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About FabFilter Pro-R 2

As one of the most used effects in the audio world, reverbs come in all forms and flavors. From convolution
(impulse response or IR) processors, to algorithmic models or emulations of vintage classics, you have probably
tried them all. While convolution reverbs may sound convincing, they are not very flexible and often so dense
that it's difficult to make them fit in a mix. On the other hand, many algorithmic reverbs are not dense enough,
sound artificial or offer so many technical options that they are simply too difficult to set up.

For us, a high-quality algorithmic reverb should sound natural or vintage, has enough density and still sits in
the mix perfectly without causing undesirable coloration or phase problems. At the same time, it should not
confuse you with over-technical controls and too many options, but must be easy to set up and a joy to work
with. With FabFilter Pro-R 2, we have aimed to create just that.
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New in version 2

e Added full immersive / Dolby Atmos functionality, with channel layouts up to 9.1.6. A lot of time has been
spent to implement surround cross feeding, resulting in an exceptionally convincing 'sense of space'.

e Introducing two brand-new reverb algorithms: Vintage and Plate.

e Added a Ducking control, offering a fast and easy way to get better separation between wet and dry
signals.

e Added a Thickness control, which applies an intuitive combination of density and saturation. Note: The
audible effect can vary quite a lot depending on the program material.

e Added Impulse response import feature. You can now import IR files (WAV and AIFF), which will be
analyzed by Pro-R, after which it will choose proper settings, decay rate and output EQ, to match the
sound of the IR as well as possible. Try it, it's magic!

e Added Auto Gate functionality, including a gate time and host sync options.

e Added optional Speakers options for Decay Rate and Post EQ curves in surround/immersive layouts,
offering much more control over decay times in a room model.

e Added mid/side and L/R option for the output EQ curves.
e Added Freeze button.

e Introducing a full-featured preset browser, with support for tags, favorites and easy searching and
filtering.

e Added output level metering.




e Added optional piano display scale for the interactive reverb display.

Increased Decay Rate knob range to go from 25% to 400%.

Other key features

Beautifully designed room models, ranging from small ambiences and rooms to large concert halls and
huge cathedrals.

Carefully developed to easily fit in the mix, without causing undesirable coloration, density or phase
problems.

Gorgeous Retina interface with large interactive reverb display featuring Decay Rate EQ and Post EQ
curves.

Very easy to set up, with comprehensible, non-technical controls:

e Stepless Space control, which smartly and smoothly combines the room model and decay time of
the reverb. You can choose from over a dozen carefully designed room models and seamlessly vary
between them, without hearing clicks or unwanted artifacts.

e Decay Rate control, changing the overall decay time from 50% to 200% of the current Space
setting.

e Intelligent Stereo Width control, ranging from pure mono to true stereo and beyond.
e Distance control to adjust the proximity to the sound source in the selected space.

e The Character control changes the sound from a clean, transparent decay, to a lively reverb with
pronounced reflections and echoes, all the way to an over-modulated chorus-like effect.

e Perfectly tuned Brightness knob, affecting not only overall brightness, but also the decay of high
frequencies.

e Mix knob with a Lock Mix option, which prevents preset loading from overriding the current mix
setting.

e Predelay knob, ranging from 0 to 500 ms, with optional host tempo sync.

Innovative 6-band Decay Rate EQ, with Low/High Shelf, Bell and Notch filters. Compared to the
commonly used low- and high crossover system, the Decay Rate EQ opens a world of possibilities by
giving you full control over the decay rate at different frequencies.

6-band Post EQ to equalize the final reverb sound, with Low/High Cut up to 96 dB/oct, Low/High Shelf
and Bell filters. Together with the Decay Rate EQ, this lets you design reverbs of any style and character.

Real-time spectrum analyzer that also visualizes the decay time at different frequencies.
Full Screen mode, offering a large analyzer display and reverb Decay Rate EQ and Post EQ controller.

Multiple interface sizes and scaling options.
Supports common Pro Tools hardware control surfaces.

FabFilter Pro-R 2 is available in VST, VST3, AU (Audio Units), AAX Native and AudioSuite formats.

Windows requirements macOS requirements

Windows 11, 10, 8, 7 or Vista macOS 10.13 or higher (64-bit only)
64-bit or 32-bit AU or VST 2/3 host or Pro Tools
VST 2/3 host or Pro Tools Intel or Apple Silicon processor

In addition, you can find the AUv3 version of Pro-R 2 for iPad in the iOS App Store.

Next: Quick start

See Also
Using FabFilter Pro-R 2



Quick start

The installer will copy the FabFilter Pro-R 2 plug-in into the common VST, VST 3, AU (macOS only) and
Pro Tools plug-in folders on your computer. On macOS, the global plug-in folders in /Library/Audio/Plug-
Ins are used.

In most cases, your host will then recognize the plugin automatically. However, if the instructions below
do not work, see Manual installation instead.

Pro Tools
Choose an empty insert slot on one of your audio tracks, instrument tracks or buses and select
FabFilter Pro-R 2 from the pop-up menu in the Reverb section.

Studio One
Click the '+' button next to the Inserts tab of an audio track, instrument track or bus and select
'FabFilter Pro-R 2' from the drop-down menu.

Logic Pro

Choose an empty insert slot on one of your audio tracks, instrument tracks or buses and select
FabFilter Pro-R 2 from the pop-up menu. You will find FabFilter Pro-R 2 in the Audio Units >
FabFilter section (named Pro-R 2).

Ableton Live

In Session view, select the track you would like to place FabFilter Pro-R 2 on, for example by
clicking the track name. At the left top of Ableton Live's interface, click on the Plug-in Device
Browser icon (third icon from the top). From the plug-ins list, double-click FabFilter/FabFilter Pro-R
2, or drag it onto the track.

Cubase

Choose an empty insert slot, for example in the Mixer, and select FabFilter Pro-R 2 from the menu
that appears. To use the MIDI features in Pro-R 2, create a new MIDI track and set its output to
the Pro-R 2 instance you have just created. (The VST 3 version of Pro-R 2 can be found in the
Reverb section.)

To begin, just choose one of the excellent factory presets as a starting point. Then experiment with the
main reverb controls to hear the effect they have on the sound. Enjoy!

Next: Using FabFilter Pro-R 2

See Also
Manual installation
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Overview

The interface of FabFilter Pro-R 2 is designed to be easy to use while providing all necessary information and controls. It
consists of the following elements:

undo/redo and a/b presets help full screen
button
oE fO bfi ”er Pf 0O-R 2 A/D Copy Vintage Hall
Vintage
G,\ EQ scale
decay rate e and range
scale ‘ CHARACTER THICKNESS t i
output level
meter
interactive
reverb
display
piano display
button

MIDI Learn v Reverb+Post o In: 0.0dB  Out: 0.0dB

midi learn analyzer settings output options resize button

o Main controls
The top section of the plug-in contains the most important controls for the reverb algorithm: Space, Decay Rate, Style,
Predelay, Character, Brightness, Distance, Thickness, Ducking, Auto Gate, Stereo Width, Freeze and Mix. See Main
controls.

o Reverb display
The interactive reverb display fills the larger bottom part of the interface. See Decay Rate EQ, Post EQ and Spectrum

analyzer.

e MIDI Learn
MIDI Learn lets you easily associate any MIDI controller with any plug-in parameter. See MIDI Learn.

e Input and output options
At the right of the bottom bar, you can bypass the entire plug-in and adjust the initial input and final output levels. See

Input and output options.

e Full Screen mode, resizing and scaling
The Resize button at the far right of the bottom bar lets you change the interface size and scaling. In addition, click the
Full Screen button in the top-right corner of the interface to let Pro-R 2 fill the entire screen. See Full Screen mode,
resizing and scaling.

e Presets, undo, A/B, help
With the preset buttons, you can easily browse through the factory presets, import impulse response files or save your
own settings so you can re-use them in other songs. The Undo, Redo, A/B and Copy buttons at the top of the plug-in
interface enable you to undo your changes and switch between different states of the plug-in. Finally, the Help menu
provides access to help and version information. See Loading presets and Undo, redo, A/B switch.

Next: Knobs
See Also

Quick start
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Knobs

It is easy to control FabFilter Pro-R 2's parameters with the large round knobs. They will light up when
you move the mouse cursor around to indicate that you can adjust them. The moment you move the
mouse cursor over a knob, a parameter value display will pop up, which shows the name and the current
value of the parameter.

All knobs support three ways of control:

1. Vertical mode
Click on a knob and drag up or down to rotate it. The knob reacts to the speed with which you
are dragging, so if you move the mouse slowly, you make precise adjustments.

2. Mouse wheel mode
Perhaps the easiest way to make adjustments is by using the mouse wheel when you hover over
a knob. This mode works for all the knobs and possible panning rings. (On Windows, you might
need to click in the plug-in interface first to make sure it is the active window.)

3. Text entry mode
Double-click a knob to enter an exact value using the keyboard.

Tips
e To reset a knob to its default position, hold down the Ctrl key (Windows) or Command key

(macO0S) and click the knob once. Note: In Pro Tools, Pro-R 2 uses the default Pro Tools keyboard
shortcut for reset: Alt+click.

e To fine-tune a value when using vertical drag mode or the mouse wheel, hold down the Shift key
while dragging or moving the mouse wheel. Note: In Pro Tools, Pro-R 2 uses the default Pro Tools
keyboard shortcut for fine tune: Ctr/+drag on Windows or Command+drag on macOS.

e There are several handy shortcuts in text entry mode. With frequency values, you can type e.g.
'1k' to set the value to 1000 Hz, and also 'A4' for 440 Hz, or even strings like 'C#3+13'. With dB
values, you can type e.g. '2x' to get +6 dB (the value that corresponds to two times louder). With
all values, you can also type a percentage (e.g. '50%"' will put a knob exactly in the middle
position).

e Sometimes, knobs in our plug-in interfaces are linked: these can be adjusted simultaneously by
holding down the Alt key (Shift key in Pro Tools) while dragging on one of them. For example, an
output level and input level setting of a plug-in could be adjusted simultaneously (in the opposite
direction) this way.

Next: Main controls

See Also

Using on i0OS
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Main controls

FabFilter Pro-R 2 offers a row of intuitive main controls to control the behavior of the reverb algorithm:
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e Prominent at the center, the Space knob is obviously the most important control of Pro-R 2. It smartly
and smoothly combines the room model and decay time of the reverb, ranging from a very small
ambience space (200 ms) to a cathedral-like ten-second reverb. With this single control, you can
choose from over a dozen carefully designed room models and seamlessly vary between them, without
hearing clicks or unwanted artifacts. The decay time varies automatically to match the room model.
The yellow time label in the Space knob shows the current reverb decay time (possibly affected by the
Decay Rate setting). Tip: As a shortcut, you can directly click the room icons around the Space knob.

e The Decay Rate control lets you adjust the reverb decay from 25% to 400% of the decay that
corresponds to the current Space setting. This allows you to easily fine-tune a room model to have the
decay that it needs in the mix. The yellow time label in the Space knob will always display the final
reverb decay time, together with the original time and decay rate if not at 100%.

e The Style button above Character and Brightness selects one of the three available reverb styles:

e Modern: This is the original Pro-R version 1 style, which is the best style to create very natural,
realistic sounding spaces.

e Vintage: Based on the sound and character of the early digital reverbs. It excels in the large
spaces and longer decay times, bringing lots of character and beautiful shimmer.

e Plate: Replicates the sound of vintage plate reverbs, with quite a fast build up and a pleasant
metallic vibe to it.

e The Predelay knob controls the initial delay between the original sound and the start of the reverb.
Adding a bit of predelay increases the separation between the original sound and its reverb tail. For
example, moving the reverb tail away from a vocal can highly improve the clarity and transparency of
a mix. Predelay also contributes to the sense of space. Higher predelay settings tend to increase the
perceived room size. Increasing predelay instead of the overall decay time can work well in achieving
a less intrusive, more natural reverb that sits better in a mix.

e The Predelay Sync button at the top of the knob lets you easily synchronize the predelay time to
host tempo. By default, synching is off and the normal delay time is used. Other options are: Quarter
Note, 8th Note, 16th Note and 32th Note. The Predelay Offset knob replaces the normal Predelay
time knob as soon as Predelay Sync is enabled. The offset knob lets you scale the predelay from 50%
to 200% of the synchronized time. This way, you can easily achieve dotted (150%) or triplet (67%)
effects.

e The Character control brings life to the reverb sound in various ways. At 0%, the reverb is as
transparent and predictable as possible. Turning the knob up to 50% gradually introduces some
modulation and more pronounced early reflections together with subtle yet noticeable late echoes.
From 50% and up, the reverb begins modulating more and more, up to a chorus-like effect at 100%
which works well on vocals and synths.

e The Thickness control applies an intuitive combination of density and saturation. Turning it up will
make the reverb more dense, but will also introduce subtle non-linearities and dynamics to the sound.
Turning it down will result in a more airy, sparse reverb. Note: The audible effect can vary quite a lot
depending on the program material.

e The Distance knob controls the effect of moving closer to, or further away from the sound source in
the modelled space. At 0%, the reverb sounds as if you are quite close to the sound source, with more
pronounced and brighter early reflections. Increasing the Distance sounds like walking away from the
sound source in the current space, resulting in a longer build-up and a more diffuse tail.

e The Brightness knob adjusts the clarity and high/low frequency balance of the reverb. Lower
Brightness values correspond to spaces with more high-frequency absorption. In real spaces, high
frequencies are very easily absorbed, depending on the surface of walls and curtains or objects in the
room. The average room or hall has a pretty dark reverb sound. Therefore, turning down the
Brightness a bit often gives you a more natural and realistic sounding reverb.

e The Stereo Width knob adjusts the apparent width of the reverb sound. It does not just mix the
output signal to mono, but also controls internal stereo linking and channel cross-feeding. Starting at
0% (mono), increasing the stereo width slowly makes the reverb true stereo. At 50%, channel cross-



feeding is at its maximum: a sound that originates in one input channel, reverberates with an equal
amount in both channels. Increasing the value from 50% up, slowly re-introduces stereo placement,
up to a 100% where channels operate completely independent (i.e. multi-mono). Above 100%, the

side signal is amplified which can be useful to achieve better mono compatibility.

e The Ducking knobs sets the range of the integrated, intelligent ducking feature. It's a fast and easy
way to get better separation between wet and dry signals, especially for vocals. Ducking triggers on
the input signal of the plug-in.

e The Auto Gate button enables and controls the automatic gating feature. Click the enable button at
the left to turn auto-gating on or off. Drag vertically on the button to set the hold time, or click the
sync button on the right to choose a time depending on host tempo, just like with Predelay. The auto
gate triggers on the input signal of the plug-in and the intelligent algorithm has automatic threshold
and attack/release settings, tuned to work perfectly when applied to separate drum sounds. Be
creative and do try auto gate on other program material as well. The results can be surprisingly good!

e The Freeze button above the Mix knob will bring the reverb in a state of 'eternal' decay, reusing only
the existing contents of the 'reverb tank' until you disable Freeze mode again. Some controls, like
Distance and Thickness, won't affect the sound anymore since they are mainly applied to the input of
the reverb. Others, like Character, Brightness, Ducking and Auto Gate, can still be adjusted. If you
click and hold the Freeze button, the reverb is frozen only while you're holding the mouse down.

e The Mix knob controls the dry/wet balance of the final reverb sound. If you are using Pro-R 2 as a
send effect, you should set it to 100%.

e The small Lock Mix button underneath the Mix knob locks the mix setting to its current value while
loading presets, so you can more easily compare different settings. When locked, you can still
manually change the mix or automate it if desired, and the mix value is always saved with your
session. If you change the Lock Mix setting, new Pro-R 2 instances will automatically pick up the new
setting.

Next: Decay Rate EQ

See Also

Using FabFilter Pro-R 2
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Decay Rate EQ

Many traditional algorithmic reverbs offer a low/high crossover system to let you change the decay rate
of low frequencies and high frequencies independently. This allows you to make more natural sounding
room models: in real spaces high frequencies often decay quite fast while bass frequencies stick around
much longer. Shown as a waterfall diagram, visualizing the decay per frequency over time, it looks like

this:

&
&
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The effect of a crossover system with lows set to 200% and highs set to 50% of the decay time.

FabFilter Pro-R 2 takes this concept to the next level with the introduction of Decay Rate EQ. With the
blue line in the reverb display, you can freely shape the decay rate over the frequency spectrum using up
to six Bell, High/Low Shelf or Notch curves, opening a world of possibilities to design reverbs of any style
and character. For example, you could extend the decay time at some frequencies while shortening the

decay time at other parts of the spectrum:

Using Pro-R 2's Decay Rate EQ, you can shape the decay time per frequency using Bell, Shelf and Notch
curves...
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. which opens a world of possibilities when designing your reverb sound.

Creating Decay Rate EQ bands

e To add a new Decay Rate EQ band, simply click on the blue Decay Rate curve and drag it up or
down. Dragging at the far left or far right of the display will automatically create a shelf instead of a
bell filter. You can create up to 6 different bands.

e To create a notch filter, double-click or Ctrl-click (Command-click on macOS) in the bottom part of
the display.

Note that the blue Decay Rate EQ scale at the left side of the display lights up when you are working with
Decay Rate EQ bands, to separate them from the Post EQ bands.

Selecting bands
e Click the Decay Rate EQ band's dot or the colored area around it to select it.

e Click and drag in the display background to select adjacent bands by dragging a rectangle
around them. Note: this selects both Decay Rate EQ and Post EQ bands.

e Hold down Ctrl (Command on macOS) and click another dot to select multiple bands. Hold down
Shift and click a dot to select a consecutive range of bands.

e Deselect all bands by clicking anywhere on on the display background.

Adjusting and editing bands

Once you have one or more bands selected, the display highlights the shapes of the selected bands. You
can now adjust them all at the same time by dragging.

e Click and drag a selected dot to adjust the frequency and decay rate of all selected bands. If you
have multiple Decay Rate EQ bands selected, the rate of all selected bands will be scaled relative to
each other.

e Use the mouse wheel to adjust the Q setting of the selected bands, making them narrower or
wider. This works while dragging or when the mouse pointer is above a curve. Alternatively, hold
down Ctrl (Command on macOS) while dragging vertically to adjust the Q of all selected bands.

e Hold down Shift while dragging to fine-tune the settings of the selected bands.

e Hold down Alt while dragging to constrain to horizontal adjustments (frequency) or vertical
adjustments (decay rate or Q, depending on the Ctrl/Command key).

e Hold down A/t and click the dot on an EQ band once to toggle its bypass state (enabling or
disabling the band).

e Hold down Ctrl+Alt (Command+Alt on macOS) and click the dot on a Decay Rate EQ band once to
change its shape.

e Double-click a dot to enter values in the parameter value display (using the Tab key to step
through Frequency, Decay Rate and Q) or double-click the values in the parameter value display
directly. Note that you can enter frequencies in various ways, like "100", "2k", "A4" or "C#2+13".

e If you right-click on the dot for an band, a pop-up menu appears with various band settings. This
is a quick way to modify the band while you're working in the display.

Using the parameter value display

1"



When you move the mouse near a band in the display, the parameter value display appears that provides
access to all band parameters.

e Click the Enable button in the left-top corner to bypass and re-enable the band.

e Click the Shape button below the Enable button to change the shape of the band: Bell, Low Shelf,
High Shelf, or Notch.

e Click the Speakers button (multi-channel instances only) to control which speakers are affected by
the selected bands. By default, bands affect all speakers except LFE, but you can also choose to
process surrounds, sides, tops, etc. See Surround and Dolby Atmos for more info.

e Click the X button in the right-top corner to delete the band.

e Double-click any of the values in the display to enter the value directly, using the Tab key to
move from one value to the next.

The display is attached to the band near the mouse cursor. If this band is selected, the actions you take
in the display are applied to all selected bands. For example, to delete all bands, simply select them all
and then click the X button in the parameter value display for one of them.

Next: Post EQ

See Also

Using FabFilter Pro-R 2
Main controls
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Post EQ

Another key feature for shaping the reverb sound is the integrated Post EQ in FabFilter Pro-R 2. Using up
to six EQ bands, you can freely equalize the final reverb sound. The reverb gain is automatically adjusted
to compensate for EQ changes, so you don't have to manually adjust the Mix setting or the send level
while tweaking the reverb sound.

Creating Post EQ bands

e To add a new Post EQ band, simply click on the yellow Post EQ curve and drag it up or down.
Dragging at the far left or far right of the display will automatically create a shelf instead of a bell
filter. You can create up to 6 different bands.

e Alternatively, double-click or Ctrl-click (Command-click on macQOS) the display background. Double-
clicking at the far left or far right of the display will automatically create a low-cut or high-cut filter
instead of a bell filter.

Note that the yellow Post EQ scale at the right side of the display lights up when you are working with
Post EQ bands, to separate them from the Decay Rate EQ bands. You can change the scale of the display
with the display range button at the top of the Post EQ scale, choosing between a range of +/- 30 dB,
18 dB or 9 dB.

Selecting bands
e Click the Post EQ band's dot or the colored area around it to select it.

e Click and drag in the display background to select adjacent bands by dragging a rectangle
around them. Note: this selects both Post EQ and Decay Rate EQ bands.

e Hold down Ctrl (Command on macOS) and click another dot to select multiple bands. Hold down
Shift and click a dot to select a consecutive range of bands.

e Deselect all bands by clicking anywhere on on the display background.

Adjusting and editing bands

Once you have one or more bands selected, the display highlights the shapes of the selected bands. You
can now adjust them all at the same time by dragging.

e Click and drag a selected dot to adjust the frequency and gain of all selected bands. If you have
multiple Post EQ EQ bands selected, the gain of all selected bands will be scaled relative to each
other.

e Use the mouse wheel to adjust the Q setting of the selected bands, making them narrower or
wider. This works while dragging or when the mouse pointer is above a curve. Alternatively, hold
down Ctrl (Command on macOS) while dragging vertically to adjust the Q of all selected bands.

e Hold down Shift while dragging to fine-tune the settings of the selected bands.

e Hold down A/t while dragging to constrain to horizontal adjustments (frequency) or vertical
adjustments (gain or Q, depending on the Ctril/Command key).

13



Hold down A/t and click the dot on an EQ band once to toggle its bypass state (enabling or
disabling the band).

Hold down Ctr/+Alt (Command+Alt on macOS) and click the dot on a Post EQ EQ band once to
change its shape.

Hold down A/t+Shift and click the dot on an EQ band once to change its slope (only for Low/High
Cut filters).

Double-click a dot to enter values in the parameter value display (using the Tab key to step
through Frequency, Gain and Q) or double-click the values in the parameter value display directly.
Note that you can enter frequencies in various ways, like "100", "2k", "A4" or "C#2+13".

If you right-click on the dot for an band, a pop-up menu appears with various band settings. This
is a quick way to modify the band while you're working in the display.

Using the parameter value display

When you move the mouse near a band in the display, a parameter value display appears that provides
access to all band parameters.

Click the Enable button in the left-top corner to bypass and re-enable the band.

Click the Shape button in the left-bottom corner to change the shape of the band: Bell, Low Shelf,
High Shelf, Low Cut or High Cut.

Click the Stereo Placement button to control which channels are affected by the selected bands.
By default, bands affect all channels, but you can also choose to process only left, right, mid or side
information. For multi-channel instances, this button changes into a combined Speakers/Stereo
Placement button and also lets you choose which speakers are affected by the selected bands. See
Surround and Dolby Atmos for more info.

Click the X button in the right-top corner to delete the band.

Double-click any of the values in the display to enter the value directly, using the Tab key to
move from one value to the next.

The display is attached to the band near the mouse cursor. If this band is selected, the actions you take
in the display are applied to all selected bands. For example, to delete all bands, simply select them all
and then click the X button in the parameter value display for one of them.

Next: Surround and Dolby Atmos

See Also

Using FabFilter Pro-R 2
Decay Rate EQ
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Surround and Dolby Atmos

FabFilter Pro-R 2 supports all important surround/immersive audio formats, up to 9.1.6 Dolby Atmos
(depending on the DAW and plug-in format). When you add Pro-R 2 to a surround channel, the interface
automatically adapts itself to the used multi-channel format. The output level meter will show all
channels, with appropriate labels to identify them.

177.19 Hz
156.3%
Q: 0.578

Q) All Speakers
All (excl. LFE)

All Top Speakers

oF L/C/R (Front + Center)

LFE

Center
* L/R (Front)
+ Lss/Rss (Surround Side)
. Lsr/Rsr (Surround Rear)

Lts/Rts (Top Surround)

Speakers and stereo placement

When using Pro-R 2 in surround mode, the parameter value display for the Decay Rate and Post EQ
curves will show a Speakers button in the left-bottom corner, controlling which speaker sets and
channels will be affected by a curve.

The drop down menu shows a list of the available speakers sets/pairs in the current surround channel
layout. By default, all speakers are selected except the LFE channels: "All (excl. LFE)". You can choose
any specific speaker pair here, e.g. Lss/Rss (Surround Side), or a predefined set of speakers, like "All

Tops" or "L/C/R (Front + Center)".

For Post EQ curves, the menu will additionally show Stereo Placement options. By default, this is set to
"Stereo", which means that both L and R channels of the selected speakers will be affected. You can
change this to process only the left, right, mid or side information. In combination with the Speakers
setting, this lets you target specific speakers in the channel layout.

The combination of these options offers a flexible way of customizing reverb response in your virtual
space. You can easily make all top speakers less bright, or make rear speakers decay longer. The
possibilities are endless.

Surround Settings

In surround mode, a Surround Settings button in the bottom bar appears and opens a panel of
dedicated surround options. At the top of the panel, the Tilt Controller has a corresponding slider for
every main control at the top of the interface. Using this, you can tilt the behavior of the knobs in an
immersive layout. Moving a tilt slider up means more at the front, less at the back, and vice versa
moving it down.
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EFFECT TILT

CENTER TOP CROSS FEED

1gs: Customized

So for example, if you'd like the reverb to be brighter at the front of the room, but longer in the back,
then adjust the Brightness Tilt slider upwards, and move the Decay Rate Tilt slider down. Experiment
with all the tilt sliders to get a good feeling of how you can affect the immersive experience. While you
move the mouse over the tilt sliders, the corresponding main controls are highlighted so you can easily
identify how they are related.

At the bottom of the panel, LFE, Center and Top knobs adjust the wet mix level of these speakers. By
default, the LFE channel is left completely dry. The levels can be attenuated, but can also be boosted.
Adjusting the Top level in an Atmos layout affects the surround versus immersive feeling: when set low,
you get the classic surround effect, but when set higher, you become more and more part of the
immersive sound.

The Cross Feed knob controls the amount of cross feed between the different speakers and speaker
pairs (e.g. 'Center' or 'Surround Rear') of the channel layout. If set to 0%, every speaker pair operates
independently from other speaker pairs. It defaults to 100%, resulting in a very natural sounding,
immersive reverb effect.

Next: Impulse Response import

See Also

Using FabFilter Pro-R 2
Input and output options
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Impulse Response import

Pro-R 2 is a 100% algorithmic reverb, but offers the unique possibility of interpreting recorded impulse
response files of actual spaces and halls and converting them to settings that will match the
characteristics of the particular space.

Of course, the results will never match perfectly, but will certainly be 'ballpark’ and, after some optional
tweaking, offer you a great and fully customizable substitute for an IR reverb.

Post EQ

18 dB

Importing an IR file

To import an impulse response file, simply open the preset browser, choose 'Import IR...", select a WAV
or AIFF impulse response file, and choose 'Open'. The interface will show you how it loads the file data
and converts it to Decay Rate EQ, Post EQ and main control settings. The reverb style will always be set
to Modern, which is the most natural sounding style, most suitable for matching real spaces. After
importing the file, you can of course save it as a regular preset, so you can use it in your projects.

V1 Preset Folder

‘hport IR...

Save As...

Note that it's not possible to properly interpret sine sweep response files, only transient response files. If
you accidentally load a sine sweep or non-IR file, you'll see a message to warn you about this.

Next: Spectrum analyzer

See Also

Using FabFilter Pro-R 2
Decay Rate EQ
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Spectrum analyzer

To help you judge the reverb behavior and the effect of the Decay Rate EQ and Post EQ, FabFilter Pro-R 2
includes a powerful real-time frequency analyzer. By default, the analyzer shows the post-processing
spectrum, plus an informative and beautiful visualization of the reverb decay over the spectrum.

Post EQ

18 dB -

i La | | | B W | | [
Al 15‘ | ”I’I | |-1 | o | : F= | B |‘ ] 0 ‘"H ke b 2
MIDI Learn ¥ in Customized alyzer: Reverb+Post n: +6.0d8  Out: 0.0dB

The thin white line shows the real-time output spectrum, just as you may be used to in FabFilter Pro-Q
for example. Behind the white line, soft yellow curves appear that fall off and fade in relation to the
current reverb time, which might of course vary at different parts of the spectrum. At a glance, it gives
you a great impression of what the reverb sounds like and how it decays.

Reverb+Post

Off
Pre+Post

v/ Reverb+Post

In the bottom bar, you can customize what the spectrum analyzer is showing. You can choose between
Reverb+Post (default), Pre+Post or Off.

At the far right of the display, the output level meter shows the current output level per channel, which
is especially useful in surround mode. You can show or hide the output level meter with the Show Output
Level Meter item in the Help menu.

An optional piano display at the bottom of the spectrum analyzer visualizes the range of frequencies
over a regular 88-key grand piano keyboard. To show or hide the piano display, click the Piano Keyboard
button in the left bottom corner of the display. For every Decay Rate or Post EQ band, there is a
corresponding dot on the keyboard. You can interact with the dots in two ways:

e Click the dot once to quantize the associated band's frequency to the exact musical note.
e Click and drag the dot to change the frequency while keeping it quantized to musical notes.

While the piano display is active, parameter value displays that show a band's frequency will also show
that frequency as a musical note (including cents offset). Note that at any time, also if the piano display
is not showing, you can enter frequencies as musical notes. For example, you can double-click on the
Frequency knob in the band selection controls and type "D#5 +13", or "A4".
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Next: Full Screen mode, resizing and scaling

See Also

Using FabFilter Pro-R 2
Main Controls

Decay Rate EQ

Post EQ
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Full Screen mode, resizing and scaling

With just the click of a button, the Pro-R 2 interface will fill up the whole computer screen so you can
make ultra-precise adjustments and get the best view on the spectrum analyzer and filter display. To exit
Full Screen mode, just press Escape or click the Full Screen button again.

Resizing

In addition to Full Screen mode, you can also customize the normal interface size using the Resize button
at the right of the bottom bar. You can choose between Medium (the default size), Large or Extra Large.
Once you have selected a size, it will automatically become the default size for new plug-in instances.

Medium
Large
v Extra Large

Scaling >

Scaling

At the bottom of the resize menu, the Scaling submenu lets you increase or decrease the interface
scaling relative to the system default, e.g. 150% (smaller) or 300% (larger) on Retina monitors (that
have a 200% scaling by default).

When you enable Full Screen mode, the plug-in will automatically choose an appropriate scaling so that
all controls become a bit larger. The plug-in automatically remembers the chosen scalings for normal and
Full screen mode, and also per monitor type (Retina / High DPI or regular), so once you've customized
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the settings to your preference, you don't have to worry about it anymore.

v Large

Extra Large

o 100%
125%
150%
175%
v 200% (Monitor Default)
225%
250%
300%

Tips

e When using the VST3 plug-in, you can resize the plug-in interface by just dragging the window
edges to any size you like. Of course you can always go back to one of the predefined sizes with
the resize button.

e The large interface options will be greyed out in the Resize button menu if the current display is too
small to support them, and the same applies to the scaling options.

Next: Input and output options

See Also

Using FabFilter Pro-R 2
Main controls

Decay Rate E
Post EQ
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Input and output options
At the far right, the bottom bar in the interface contains the following input/output options.

The Global Bypass button lets you bypass the entire plug-in. While most hosts already provide the
ability to bypass plug-ins, our internal global bypass applies soft bypassing to avoid clicks. While the
plug-in is bypassed, the frequency analyzer and delay display feedback stops and a red line at the top of
the bypass button appears.

+6.0 dB

As soon as you hover the mouse over the output button, right next to the bypass button, a panel with
input/output/pan knobs will pop up:

e The Input Level/Pan knob at the left adjusts the level and L/R panning of the input signal before
any processing is applied.

e The Output Level/Pan knob at the right adjusts the level and L/R panning of the final output
signal.
Next: MIDI Learn

See Also

Using FabFilter Pro-R 2
Knobs

22



MIDI Learn

Controlling FabFilter Pro-R 2's parameters directly with MIDI is very easy using the MIDI Learn feature.
With MIDI Learn, you can associate any MIDI controller with any parameter.

MIDI LEARN Move a slider/knob on your MIDI controller to associate it to: Space Close

Vintage

¢y 21019 Hz
~ 48.85%

N Q:0.706

Click the MIDI Learn button in the bottom bar to enter MIDI Learn mode. The interface dims and the
parameters that can be controlled are highlighted. Each parameter has a small text balloon that displays
the associated controller number. Now do the following to associate a controller number with a
parameter:

1. Touch the control of the desired parameter in the interface that you wish to control. A red
square will mark the chosen parameter.

2. Adjust the slider or knob on your MIDI keyboard or MIDI controller that you want to associate
with that parameter.

That's it! The parameter will now be controlled with the MIDI controller. You can now go back to step 1 to
associate a different parameter. Note that there is no warning when you associate a different knob with a
controller number that is already used. It will just be replaced.

To exit MIDI Learn mode, click the MIDI Learn button again, or click Close at the top of the interface.
Click the small menu drop-down button next to the MIDI Learn button to access the MIDI Learn menu:

e Enable MIDI
This globally turns MIDI control of parameters on or off: useful in hosts that automatically send all
MIDI events on a track to all effect plug-ins associated with that track as well.

e Clear
This submenu shows all parameter associations and lets you delete individual associations or clear
all associations in one step.

e Revert
Reverts to the last saved MIDI mapping (or the state when the plug-in was started).

e Save
Saves the current MIDI mapping so Revert will go back to this state. The current mapping is
automatically saved when closing the plug-in.

Routing MIDI to effect plug-ins

For MIDI Learn to work properly, the plug-in need to actually receive MIDI of course. Depending on your
host, it can be quite difficult to route MIDI data to effect plug-ins. Here's how to do it in the most
important hosts:
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e Pro Tools
Create a new MIDI track. From the MIDI input drop down menu, choose your MIDI device (if not
already selected) and from the MIDI output drop down menu, choose FabFilter Pro-R 2 -> channel
1 for the instance you would like to control.

e Logic Pro
Instead of adding FabFilter Pro-R 2 to one of the insert slots, create a new Instrument Track, and
click on the Instrument slot. Then choose AU MIDI-controlled Effects > FabFilter > Pro-R 2.
Now, the plug-in receives MIDI. To get audio into the plug-in, click the 'Side Chain' drop down
menu in Logic's plug-in header and choose the actual input track. Next, you can mute that original
track, so you only hear the audio through the plug-in. The only downside is that plug-ins with an
external side-chain cannot use it anymore.

e Ableton Live
First of all, create a new MIDI track. From the 'MIDI from' drop down menu, choose your MIDI
device (if not already selected). Then, in the 'MIDI to' drop down menu, choose the Audio track
that has FabFilter Pro-R 2 on it. Note: only the first plug-in on any track can receive MIDI.

e Cubase
Simply create a new MIDI track and set its output to the Pro-R 2 instance you would like to

control via MIDI.

Next: Undo, redo, A/B switch

See Also
Using FabFilter Pro-R 2
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Undo, redo, A/B switch

The Undo and Redo buttons at the top of the FabFilter Pro-R 2 interface enable you to easily undo
changes you made to the plug-in. With the A/B feature, you can quickly switch between two different
states of the plug-in.

[ 9] A/E Copy

e The Undo button at the left will undo the last change. Every change to the plug-in (such as
dragging a knob or selecting a new preset) creates a new state in the undo history. The Undo
button steps back through the history to restore the previous states of the plug-in.

e The Redo button cancels the last undo command. It steps forward through the history until you are
back at the most recent plug-in state.

e The A/B button switches from A to B and back. Before switching, the current state of the plug-in is
saved, so if you click this button twice, you are back at the first state. The button highlights the
currently selected state (A or B). In the example above, the A state is active.

e The Copy button copies the active state to the inactive state. This marks the current state of the
plug-in and allows you to go back to it easily with the A/B button. After clicking Copy, the button
disables itself to show that both states are equal, so there is nothing to copy anymore.

Notes

e If the plug-in parameters are changed without using the plug-in interface, for example with MIDI or
automation, no new undo states are recorded.

e The Undo and Redo buttons will disable themselves if there is nothing to undo or redo.

Next: Using on iOS

See Also
Using FabFilter Pro-R 2
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Using on iOS

FabFilter Pro-R 2 is available as an AUv3 plug-in for iPad in the App
Store. Using Pro-R 2 on a touch screen is slightly different from using
it with a mouse:

To adjust a knob, just touch it and drag up or down.

For fine adjustment, hold down a second finger while you're
dragging a knob.

To reset a knob to its default position, simply double-tap it.

To type a new value directly, press and hold on a knob until the
on-screen keyboard appears. Note that the keyboard might
obscure the parameter value display — unfortunately we can't do
anything about that because an AUv3 plug-in cannot control its
own position on the screen.

In the EQ display:

Drag the result curve, or double-tap on the display background to create a new band.

You can just drag bands with your finger. To select multiple bands, draw a rectangle around them
by starting a drag on the display background. For fine adjustment, hold down a second finger just
like with knobs.

Double-tap and drag to adjust the Q of a band.

You can directly type a new value for one the the band's parameters by pressing and holding down
on the parameter value in the EQ parameter display.

To open a pop-up menu with all parameters for a band, press and hold down on the band's
control point until the menu appears. You can also tap the small menu button on the right side of
the EQ parameter display.

To delete the selected bands, just tap the small X button on the right side of the EQ parameter
display.

Unlike the regular plug-in, the AUv3 plug-in offers no resizing or full screen mode from the plug-in
interface itself: this must be provided by the host app.

To organize presets on iOS, open the preset browser and swipe to the left on any preset or subfolder to
see options to delete or edit it. When editing a preset or folder, you can rename it and move it to another
folder.

The Pro-R 2 app that contains the AUv3 plug-in serves as a stand-alone host that simply routes audio
from the microphone to the plug-in and plays it back in real-time via the speakers or headphone output.
You need to manually start the audio engine using the Audio On/Off switch at the bottom, but first make
sure that the speaker volume is not too high to avoid excessive feedback! We do recommend to use an
AUvV3 host app like Auria, Cubasis, AUM or GarageBand to take full advantage of Pro-R 2's features.

View FabFilter iOS plug-ins in the App Store @

Next: Loading presets

See Also
Overview
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Loading presets

FabFilter Pro-R 2 comes with a selection of excellent factory presets, conveniently ordered in folders
based on room size. They are great starting points and will give you a good impression of what FabFilter
Pro-R 2 is capable of.

L | Default Setting b

The preset button shows the name of the current preset. If you have changed the preset by adjusting
one or more parameters, the name is dimmed to indicate that this is not the original preset anymore.

Click the preset button to open the preset browser:

Ambience > Default Setting

small FabFilter

Medium »  default 'hall

Latge > This is the default setting
Very Large for FabFilter Pro-R 2.

Tempo Synced > | Feel free to customize it
, as you like, and save it
Basic via the options menu at
Default Setting Lhe left of the Search
OX.
Test

V1 Preset Folder

The preset browser shows all presets grouped in folders, with the current preset highlighted in blue.

Preset details

A preset can contain extra information: author, tags and a description, which is shown in the panel on
the right. These fields are present in all factory presets and can of course be edited as well: just double
click the author or description. To add a tag, click the + button. Double-click a tag to rename it, or hover
over the tag and click the x button to remove it.

Browsing presets
You can browse and select presets in various ways:

e Of course, you can simply browse using the mouse. Hover over folders to open them, and click on
a preset to load it. If you move the mouse outside the browser after selecting a preset, the browser
will close. Otherwise, it will stay open so you can look around and try multiple presets, or edit their
information.

e Within the preset browser, you can use the arrow keys to navigate, and the Enter key to load a
preset and close the browser. Use the right arrow key to load a preset without closing the browser.
Press the Esc key to close the browser without selecting anything.

e You can also click the previous/next arrow buttons around the preset button to explore presets one
by one without opening the preset browser.

e ... and while the browser is open, use the [ and ] keys to load the next or previous preset
directly.
Searching, filtering and favorites

In the preset browser, you can start typing to search through the presets, filtering on folder name,
preset name or tag. While typing, the preset browser automatically filter the current selection and update
itself to show the resulting sub set. If you've first started browsing by mouse, just click the Search
field and type to start filtering again.

You can also mark presets as favorite, by clicking the star icon next to the preset name in the preset
details panel. Click the star icon next to the Search field to show only your favorites.
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Preset browser options
Click the Options button #t at the left of the search field at the top to open a menu with extra options:

Enable MIDI Program Changes

Save As Default

Open Other Preset...

Change Preset Folder...
Restore Factory Presets
Refresh

e When Type To Search is enabled, you can start typing to search, right after you've clicked the
preset button. Disabling this will always require a click in the Search field to start searching. This
might be handy, for example if you're working without a MIDI keyboard and use letters on your
computer keyboard to play notes.

e When Enable MIDI Program Changes is active, you can load presets via MIDI program change
and bank select messages. The corresponding bank/program numbers are then shown in front of
the preset name (for example: (0/65) My Preset). This means that you can load that preset by first
sending a Bank Select message to select bank 0 and then sending a Program Change message to
select program 65.

Important: All the presets in your preset folder are numbered automatically, starting with bank 0
and program 0. This way, you are able to access any of the presets via MIDI. However, this also
means that when you add new presets to the menu, bank/program numbers of other presets might
change. Be aware of this when recording program changes in a session! We recommend to create a
dedicated folder in your presets folder for your program changes, and name it with two leading
underscores (e.g. "___Programs") to ensure it's the first folder in your preset collection and the
presets in this folder start with bank 0 and program 0.

e The Default Setting preset is loaded automatically when FabFilter Pro-R 2 is started. To change
the default settings, simply overwrite this preset by clicking Save As Default.

e To open a preset outside the presets folder, click Open Other Preset. This might be useful if
someone sends you a preset by email, for example.

e To change the location where the presets for Pro-R 2 are stored, choose Change Preset Folder
and select the desired folder.

e If somehow the factory presets are lost or not installed properly, click Restore Factory Presets to
restore them.

e If needed, for example after you've manually removed or added files in the folder while Pro-R 2 is
open, click Refresh to rescan the preset folder.

Compatibility with Pro-R 1

All presets created with Pro-R 1 can be loaded in Pro-R 2. If Pro-R 1 is also installed on your computer,
your Pro-R 1 presets will be accessible via the V1 Preset Folder submenu in the preset menu. The
factory presets for Pro-R 1 are also included in the Pro-R 2 factory presets, so you only need to use the
V1 Preset Folder submenu to access presets you might have created yourself.

You can read more about compatibility between Pro-R 1 and 2 in Upgrading to Pro-R 2. Please take some
time to read it if you are planning to replace Pro-R 1 instances with Pro-R 2 instances in your songs.

Next: Saving presets

See Also

Impulse Response import

Using on i0S
Overview

28



Saving presets

You can easily extend the included presets with new settings to build your own library of presets for
FabFilter Pro-R 2 that you can reuse in various projects. This is also a good way to copy settings across
multiple instances of FabFilter Pro-R 2 in a session.

To save the current setting as a preset, click the preset button, and then click Save As. A standard Save
dialog will appear. Type a name for the new preset and click Save to finish.

In the Save dialog, you can also rename and delete existing presets and create a new folder to store
presets in. New folders will show up as new categories in the preset menu. (On macOS, this should be
done with the Finder.)

Right-click shortcut menu

You can also right-click on the preset button to open a small menu with shortcuts:

e Favorite: Mark the current preset as favorite.

e Save: Overwrite the currently loaded preset. You will be asked for confirmation before saving.
e Save As: Just like choosing the 'Save As..."' item from the main menu.

See How presets are stored to determine the preset folder location and learn more about factory presets.

Next: How presets are stored

See Also

Loading presets
Overview
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How presets are stored

Presets for FabFilter Pro-R 2 are stored in separate files with the .ffp extension (for FabFilter Preset). All
presets reside in subfolders in the main preset folder. The subfolders will show up as separate categories
in the preset menu. You can also further divide the subfolders into categories.

You can manage the preset files just like other files on your computer. The easiest way to do this is in the
Save dialog that appears if you are saving a preset. The preset menu will automatically reload itself with
the changes when the dialog is closed.

Furthermore it is very easy to share your newly created presets with other users since FabFilter presets
use the same file format on both Windows and macOS.

The default location of the main preset folder is Documents/FabFilter/Presets/Pro-R 2 on both Windows
and macO0S. To change this location, first copy all presets to the desired new location. Click Options &t
and Change Preset Folder in the preset browser and select the new folder.

Note: previously on macOS, presets were stored in ~/Library/Audio/Presets/FabFilter/FabFilter Pro-R 2.
To determine the current location of the presets folder, click Options ¥ and Change Preset Folder in
the preset browser.

Restoring factory presets

If you have accidentally lost the factory presets, you can easily restore them by clicking Options % and
Restore Factory Presets in the preset browser. This will install all factory presets again.

Next: Purchasing FabFilter Pro-R 2

See Also
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Purchasing FabFilter Pro-R 2

Once you have downloaded and installed the evaluation copy of FabFilter Pro-R 2, you may evaluate it
during 30 days. Every time you start the plug-in, you will see the following dialog:

FabFilter Pro-R 2 Evaluation

Thank you for trying FabFilter Pro-R 2!
You still have 30 days left in your
fabfilter evaluation period.

software instruments

Evaluate

Buy Now

Enter License

While there are still days left, you can click Evaluate to start working with the plugin. If you want to
keep using FabFilter Pro-R 2 after the evaluation period, you must buy a copy in the online FabFilter Shop
by clicking the Buy Now button in the evaluation dialog.

e Go to the FabFilter Shop and purchase FabFilter Pro-R 2 now &

We accept a wide range of payment methods, like credit cards, PayPal, wire transfer and iDeal. The
FabFilter Shop uses secure connections and encryption: therefore your personal information is completely
safe.

Within a few minutes after you have purchased your copy, you will receive an email containing your
personal license key. You use this license key to turn the evaluation copy into a fully registered version
without the evaluation dialog and the 30-day trial restriction. In addition, we will automatically create a
FabFilter account [ for you (if you don't have one already). Here, you can access all your license keys at
any time.

Note: If the evaluation period has expired but you didn't have the chance to properly evaluate the plug-
in, you can request a new evaluation period by contacting us at info@fabfilter.com .

Next: Entering your license key

See Also

Support
License agreement
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Entering your license key

After you have purchased FabFilter Pro-R 2 in the online FabFilter Shop &, you will immediately receive
an email containing your personal license key. This license key will turn the evaluation version into a fully
registered plug-in.
e Start FabFilter Pro-R 2 and click Enter License in the evaluation dialog, or click Enter License on

the Help menu if the plug-in is already running.

e Copy the license information from the email you have received and paste it into the text field. Make
sure that you are copying the entire license key including the Product and Licensee lines! If you are
not sure what text to copy, just copy and paste the whole email.

Enter License

Please copy your license key from the email that you have
received after your purchase, and paste it below.

Paste

Cancel | SN

After you have entered your license information, you will need to restart the plug-in host, so make sure
you save your settings if needed. From now on, you will be able to use FabFilter Pro-R 2 for an unlimited
period of time with full support via email.

Tips
e After your purchase, you can always retrieve your license key again by logging into your personal

FabFilter account @. Here you can also keep track of all your orders and take advantage of great
discounts when buying other FabFilter plug-ins.

e To deauthorize your license key and remove it from the computer, click Deauthorize on the Help
menu. If you temporarily needed to install your license on another computer, or if you have
transferred your license to someone else, this is the way to deinstall your personal license key
safely.

Next: Support

See Also
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Support

If you need help with problems or questions, and the help file does not provide an answer, please visit
the support pages on our web site.

e Go to FabFilter Support

From here, you have direct access to the customer support forum, very useful tutorial videos for all
FabFilter plug-ins, online and PDF versions of all our help files, and a section with extra downloads (such
as presets, controller templates, older plug-in versions).

For sales-related questions and technical support, you can also contact FabFilter directly at
info@fabfilter.com.

Reporting a bug

If you have encountered a bug in FabFilter Pro-R 2, first of all make sure that you are using the latest
version of the plug-in, which you can find at www.fabfilter.com/download Z. You can easily check the
version of FabFilter Pro-R 2 that you are using by clicking Help > About in the plug-in interface. If the
bug is still present in the latest version, please send us an e-mail at info@fabfilter.com and include as
much technical information as possible: operation system and version, host software and version, steps
to reproduce the bug, etc. Thanks in advance!

Next: Upgrading to Pro-R 2

See Also
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Upgrading to Pro-R 2

Upgrading from Pro-R 1 to Pro-R 2 is safe and easy: installing Pro-R 2 will not replace or delete the
previous versions of the plug-in. All versions will co-exist and can be used at the same time. This ensures
that you can open old songs that use Pro-R 1 without problems.

Pro-R 1 presets

All presets created with Pro-R 1 can be loaded in Pro-R 2, and they will sound 99% the same (version 2
has some improvements in processing quality). If you upgraded from version 1 to the new version, your
original presets will be accessible via the V1 Preset Folder item in the preset browser. See also Loading

presets.
Replacing a Pro-R 1 instance by Pro-R 2

If you are working on a song and want to replace a Pro-R version 1 instance with the new Pro-R 2, we
advise you to do the following:

e First, save the current setting of the original Pro-R instance as a FabFilter preset in the Pro-R 1
preset folder.

e Then, remove the original Pro-R instance and add Pro-R 2 in its place.

e Finally, load the V1 preset that you just created into Pro-R 2 via the V1 Preset Folder submenu in
the preset browser.

Automation

Because the feature set of Pro-R 2 has changed fundamentally, any automation data that has been

written by a Pro-R 1 instance cannot be read correctly by Pro-R 2.
Next: Manual installation
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Overview
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Manual installation

When installing FabFilter Pro-R 2, the installation program will try to copy the plug-in into the appropriate
plug-ins folders, and in most cases your host will recognize FabFilter Pro-R 2 automatically. Otherwise,
please follow these instructions:

Windows

On Windows, most hosts have their own VST plug-ins folder. So if you are using Windows and your host
does not recognize FabFilter Pro-R 2, you need to locate the proper plug-ins folder for your host first (it is
usually shown in the Preferences or similar dialog). Then, copy the file FabFilter Pro-R 2.dlIl from
C:\Program Files\FabFilter\Pro-R 2 (or C:\Program Files (x86)\FabFilter\Pro-R 2 if you are using a 32-bit
host on 64-bit Windows) to the plug-ins folder that you have found and restart the host so it can reload
all its plug-ins. For the AAX version of Pro-R 2, copy the FabFilter Pro-R 2.aaxplugin folder to the common
Pro Tools AAX plug-in folder on your computer.

You can simply uninstall plug-ins or bundles via the Control Panel.

macO0S

On macOS, plug-ins are installed in the standard plug-in folders in the system Library folder. These are
the only possible correct locations:

e Audio Units: /Library/Audio/Plug-Ins/Components
e VST/VST3: /Library/Audio/Plug-Ins/VST and /Library/Audio/Plug-Ins/VST3
e AAX: /Library/Application Support/Avid/Audio/Plug-Ins

Note: AU and VST/VST3 plug-ins may also be placed in the user's Library folders under
/Users/<username>/Library/Audio/Plug-Ins.

To uninstall the plug-ins from your Mac, you can just delete the specific FabFilter plug-in files at the
above locations. Finally, if you really want to delete all data written by our plug-ins, you can remove the
following folders/files from the user Library folder as well:

e /Users/<username>/Library/Audio/Presets/FabFilter/FabFilter Pro-R 2
e /Users/<username>/Library/Application Support/FabFilter/Pro-R 2
e /Users/<username>/Library/Preferences/com.fabfilter.Pro-R.2.plist

Note: Since OS X 10.7 (Lion), the system and user Library folders are marked as hidden by default. To
make them visible again in Finder, open Terminal (found in /Applications/Utilities) and enter the following
commands:

chflags nohidden /Library
chflags nohidden ~/Library

If you still have problems, contact FabFilter Support .

Next: VST plug-in versions
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VST plug-in versions

FabFilter Pro-R 2 is available in both VST 2 and VST 3 formats. They can be installed and used both at
the same time. The VST 3 format offers free interface resizing and is more CPU-friendly in some cases,
but it can only be used by hosts that support it, for example recent versions of Cubase, Studio One or FL
Studio. The VST 2 format is compatible with a larger variety of hosts.

Both the VST 2 and VST 3 versions of the plug-in automatically adapt themselves to the channel layout of
the track they are inserted on (mono/stereo and surround).

Next: License Agreement
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FabFilter Software License Agreement

This license agreement concerns and describes your rights and the conditions upon which you may use
the FabFilter software you selected. We advise you to read this entire agreement. By accepting this
agreement or by using FabFilter software, you agree to all of these terms. If you do not accept and
comply with these terms, you may not use the FabFilter software or its features.

Applicability

This license agreement applies to all the FabFilter software, plug-ins and programs you may use during
the Evaluation period, and/or thereafter subject to an acquired license key to certain FabFilter software of
any version, including any and all upgrades, supplements or services, unless other terms come with such
versions, upgrades or supplements.

Licenses

The software will be licensed to the Customer, not sold. With the FabFilter license key, you will be
granted after full payment the right in perpetuity (meaning that the license agreement shall not
automatically expire) to install, run and use the software concerned under certain conditions. These
conditions vary subject to the license you acquired. FabFilter distinguishes the following licenses:

e A Personal License is a named license to the software concerned, granting access to the software
on an unlimited number of Devices, as long the license is used by the designated person who
acquired the FabFilter license key. Usage of the Personal license by someone else but the
designated licensee is an infringement of the rights of FabFilter. The Customer should at all times
protect its license key from theft and/or abuse.

e A Site License is a non-personal license to the FabFilter software concerned, acquired on the name
of an institution or entity, who is the licensee. A Site License will grant access to the FabFilter
software on a certain maximum number of designated Devices, as specified in the license key itself
(e.g. "20 seats"). If the Site License is used on computers/servers for any form of automated
processing, the licensee may not make any plug-in controls/parameters of the FabFilter software
available to the end users of the FabFilter software, i.e. only "black box" processing is allowed.

These FabFilter licenses, whether a Personal or Site License, will give you access to certain FabFilter
software of the specified major version. The license will include all future minor updates to the software
(e.g. version 2.19 to version 2.20), which typically include bug fixes or small new features. The license
will exclude any future new major versions of the products (e.g. version 1.x to version 2.x). To allow
yourself access to such new major version of the software, a new FabFilter license to such major version
must be acquired.

All FabFilter licenses, both Personal or Site License, give the Customer or end user the right to install and
use the FabFilter software to the extent it has been developed and under the conditions herein. Any
rights not explicitly granted to you, the Customer, remain with FabFilter, including but not limited to the
right to alter, reverse engineer, reverse compile, take apart, or disassemble the FabFilter software or any
of the files in the distribution.

A Bundle License is Personal or Site License for multiple FabFilter software products, which gives the
Customer or end user the right to install and use the specific software products that the bundle (e.g.
Total Bundle) contains at the moment of purchasing the Bundle License. Any software products or new
major software versions added to the bundle after that date cannot be claimed as part of the prior
acquired Bundle License. A Bundle License (if not Educational or NFR) can only be transferred as a whole,
using a License Transfer.

An Upgrade License is a Personal or Site License for a new major version of FabFilter software. You may
only use an Upgrade License if you have a license for the previous major version of the same FabFilter
software.

Educational (EDU) and NFR licenses

A Personal or Site License can be marked as EDU (Educational) or NFR (Not For Resale), meaning the
following:

e A Personal or Site License marked as Educational License is equal to the respective Personal or Site
License, with the only exception that the Educational License may not be transferred to a third
party.

e A Personal or Site License marked as NFR ("Not For Resale"), is typically intended for journalists
that wish to review the FabFilter software. A License marked as NFR is equal to the respective

Personal or Site License, with the only exception that the NFR License may not be transferred to a
third party.

Duration and Evaluation

As specified in the specific terms per license, all licenses will be granted for perpetuity (meaning that the
license agreement shall not automatically expire), as long as all conditions herein are respected.
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The Evaluation period is a period of thirty (30) days commencing on the first day of using the software
concerned and automatically expiring 30 days thereafter. After the Evaluation period has expired and no
FabFilter license key has been acquired, the software will stop working and should be removed from your
computer.

In addition to any and all such possibilities that FabFilter may have in accordance with the law, FabFilter
may terminate without prior notice or warning in case of abuse of the FabFilter software as well as in
case of (personal) bankruptcy.

Support

FabFilter shall give its reasonable commercial efforts to service any major version of any FabFilter
software including email support. FabFilter is entitled to terminate support for any major version of any
FabFilter software at any time at its sole discretion.

License Transfer

A Personal or Site License (not Educational or NFR) may be transferred to a third party. You will have to
buy a License Transfer to activate the "transfer"-option in your FabFilter account . After this option has
been activated you will be able to transfer your license to any third party.

Third Party Software

VST is a trademark of Steinberg Media Technologies GmbH. RTAS and AAX are trademarks of Avid
Technology, inc. Audio Units is a trademark of Apple Computer, inc.

Applicable Law

This license agreement is governed by Dutch law. The courts of Amsterdam are authorized courts to rule
on any dispute that may arise from this license agreement.

Disclaimer

TO THE MAXIMUM EXTENT PERMITTED BY LAW, FABFILTER, FREDERIK SLIJKERMAN AND FLORIS
KLINKERT, AUTHORS OF THIS FABFILTER PRODUCT, SPECIFICALLY DISCLAIM ALL WARRANTIES,
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF NON-
INFRINGEMENT, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FABFILTER, FREDERIK
SLIJKERMAN AND FLORIS KLINKERT, DO NOT WARRANT THAT THE SOFTWARE WILL MEET YOUR
REQUIREMENTS OR THAT THE SOFTWARE WILL OPERATE ERROR-FREE OR UNINTERRUPTED. TO THE
MAXIMUM EXTENT PERMITTED BY LAW, FABFILTER, FREDERIK SLIJKERMAN AND FLORIS KLINKERT,
SHALL NOT BE LIABLE FOR ANY DAMAGE A FABFILTER PRODUCT MAY CAUSE OR DAMAGES THAT MAY
ARISE OUT OF THE USE OF A FABFILTER PRODUCT OR INABILITY TO USE A FABFILTER PRODUCT,
INCLUDING BUT NOT LIMITED TO SPECIAL, INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES. IN NO
EVENT FABFILTER, FREDERIK SLIJKERMAN OR FLORIS KLINKERT WILL BE LIABLE FOR AN AMOUNT IN
EXCESS OF TWO HUNDRED FIFTY EUROS (€ 250,00).
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About FabFilter

Beautiful sound. Fantastic workflow. These are the foundations of FabFilter. We create powerful audio
plug-ins with superb sound quality and innovative interfaces.

A unique perspective

At FabFilter, we make the best possible tools for music production and audio processing. To achieve this,
we continually rethink and challenge industry standards: we've never been afraid of reinventing the
wheel. Considering every little detail, we tune our algorithms and interfaces until they sound perfect, look
amazing and feel great to work with.

It's the sound that counts

Above everything else, you need superb sound quality. That's why we put a lot of effort into developing
unique audio processing algorithms, ranging from our famous resonating filters to transparent high-end
EQ and dynamics processing.

Innovative interfaces, great design

Every FabFilter plug-in has an easy-to-use, well-designed interface aimed at providing unsurpassed
workflow. Our plug-ins focus on the task you're performing at that specific moment: they expose the
features you need, when you need them. And because of our special attention to design, you'll be
delighted every time you open a FabFilter plug-in.

Don't take our word for it

We always set the highest standard for sound quality, usability and design to make truly great products
that raise the bar on what audio software can do. That's why we're very happy with the praise we've
received from users and press alike:

"In the decade since the release of its first plug-in, One, FabFilter has made an indelible mark
on the music production landscape." — Computer Music magazine

"While many other software developers are busy trying to model hardware, FabFilter is leaving
them in the dust by being visionaries and reaching into the future. FabFilter stuff is just on
another level." — Jeff Sanders

"FabFilter has an enviable reputation for making easy-to-use, powerful tools." — Music Tech
magazine

FabFilter was founded in 2002 by Frederik Slijkerman and Floris Klinkert, and is based in Amsterdam, The
Netherlands.
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